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ABSTRACT 

 The objectives of this research were to: 1) compare the 1st year of secondary 

vocational students learning achievement on the Fundamentals of Computer Application 

studying through the scaffolding teaching to 70 percent criteria, and 2) compare the pre- 

and post-learning achievement of the students studying through the scaffolding teaching.   
 The research samples were 10 students, selected by purposive sampling, the 1st 

year secondary vocational students studying the Fundamentals of Computer Application 

at Zigong Vocational and Technical School, China, in the academic year 2022. The 

research instruments consisted of: 1) a learning management plan based on the 

scaffolding teaching, and 2) an achievement test. The mean, percentage, standard 

deviations, and t-test were used for data analysis. 

 The research results showed that:1) the 1st year secondary vocational students’ 

learning achievement on the fundamentals of Computer Application studying through the 

scaffolding was 70% higher at the statistical significance level of .05, and 2) the post-

learning achievement of the students studying through scaffolding was higher than the 

pre-learning at the statistical significance level of .05. 
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CHAPTER 1 

INTRODUCTION 

 

1.1 Background and Statement of the Problems  

 Vocational education was an essential part of China's education system, which 

undertook the critical task of providing professional and technical talents for social and 

economic development. In order to promote the quality of Vocational Education in China, 

the Ministry of Education and other competent departments issued a series of policy 

documents in recent years, requiring local vocational education schools to make the 

greatest use of all kinds of emerging educational ideas, methods, technologies, and tools 

to effectively strengthen the innovation of teaching models. Furthermore, this also 

improved the teaching quality of vocational education and played an essential role in 

professional talent training (Cheng Xiangqian, 2021, p.28). 

 The emergence of information technology has provided good technical 

conditions for the innovation of the vocational education model. In 2017, the Ministry of 

Education issued guidelines on further promoting the informatization development of 

Vocational Education (Hu yunqi et al., 2019, pp.86-87). Subsequently, these guidelines 

were referred to as the Guiding Opinions. They required vocational education schools at 

all levels to actively engage in the innovation and practice of teaching modes based on 

the information environment. The aim was to transform the traditional vocational 

teaching mode by leveraging information technology and promote the deep and wide 

development of vocational education informatization (Li Fang and Shi Yuxin, 2020, 

p.15). As a result of these guiding opinions, many innovative vocational teaching models 

based on information technology emerged in China. 

 In general, the innovation of these vocational teaching modes relies on 

information technology, which primarily offers more efficient and convenient application 

platforms and tool support for traditional teaching. This helps establish a teaching system 

that combines online and offline methods to enhance the quality and effectiveness of 

teaching. Therefore, in order to fully leverage the advantages of information technology 

in vocational education, it was crucial to integrate it with traditional teaching. Scaffolding 

teaching, which was an important practical approach based on Constructivism Theory in 
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pedagogy, has been widely and currently adopted in the domestic vocational education 

system (Aslan, 2021, pp.237-249). 

 Based on my teaching practice in a secondary vocational school (referred to as 

the secondary vocational school from now on), this study integrates information 

technology with traditional scaffolding teaching. It involves designing online scaffolding 

teaching and applying it to the teaching activities of the "Fundamentals of Computer 

Application" course in the secondary vocational school. 

 "Fundamentals of Computer Application" was a fundamental introductory 

course offered in secondary vocational schools. The teaching goal of this course was to 

develop students' computer processing skills, introduce them to basic computer 

theoretical knowledge, and enhance their abilities in simple information management. 

The aim was to improve their overall computer application skills and align with the 

fundamental spirit of "Employment Orientation" in Vocational Education. Consequently, 

the course "Fundamentals of Computer Application" encompasses both practical and 

theoretical aspects, as its teaching outcomes significantly influence the successful 

employment of secondary vocational students. 

 However, given the relatively low academic proficiency of students in 

secondary vocational schools, most students have weak computer application skills and 

limited knowledge in this area prior to enrolling. Additionally, the technical and practical 

requirements of the course itself are relatively demanding. As a result, traditional teaching 

methods often fail to achieve the desired teaching objectives. Hence, teachers need to 

seek innovative approaches in their teaching methodologies. 

 In recent years, various new teaching modes have emerged, and among them, 

scaffolding has gained prominence. Scaffolding offers personalized teaching, enhances 

students' self-directed learning abilities, and reduces frustration. Inspired by the concept 

of "scaffold" in the construction industry, scaffolding teaching likens the learning goal to 

a "building." Teachers assume the role of providing the necessary "scaffold" for 

constructing this "building," assisting students in gradually establishing and completing 

the required knowledge and technical structure (Han Xiao, 2019, pp.154-156). 

 In scaffolding teaching, teachers first analyze the teaching objectives and then 

create the essential "scaffold" to support the learning of relevant concepts and the learning 
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framework. The teaching process involves creating situations, encouraging independent 

exploration, facilitating collaborative learning, and more. Finally, a comprehensive 

evaluation of learning outcomes, students' self-directed learning abilities, and 

collaborative learning abilities takes place, which can encompass teacher-student 

evaluation, self-evaluation by students, and peer evaluation. The recent development zone 

can be utilized to plan and enhance the teaching process and strategies within scaffolding 

teaching. Teachers should assist students in constructing and dismantling the "scaffold" 

to foster the development of their knowledge and skill structures. The aforementioned 

"scaffold" was essential for students to successfully transition from their current level of 

cognitive development to their potential level of development. 

 

1.2  Research Questions 

 1.2.1  Was there a statistically significant difference in the learning achievement 

of 1st year secondary vocational students on the Fundamentals of Computer Application, 

whose scores reached the 70 percent criterion, after studying through online scaffolding 

teaching? 

 1.2.2  Was there a statistically significant difference in the learning achievement 

of 1st year secondary vocational students on the Fundamentals of Computer Application 

before and after studying through online scaffolding teaching? 

 

1.3  Purpose of the Study 

 1.3.1 To compare the 1st year of secondary vocational students learning 

achievement on the Fundamentals of Computer Application course studying through the 

online scaffolding teaching whose score reached 70 percent.  

 1.3.2 To compare the 1st year of secondary vocational students learning 

achievement on the Fundamentals of Computer Application course before and after 

studying through the online scaffolding teaching.   
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1.4  Research Hypothesis 

 The researcher tested the following hypotheses: 

 1.4.1  The learning achievement of 1st year secondary vocational students on 

the Fundamentals of Computer Application course, while studying through online 

scaffolding teaching and achieving a score of 70 percent or higher, showed a statistically 

significant difference at .05. 

 1.4.2  The learning achievement of 1st year secondary vocational students on 

the Fundamentals of Computer Application course after studying through online 

scaffolding teaching showed a statistically significant difference compared to before 

study at .05. 

 

1.5   Scopes of the Study  

 1.5.1 Population and Sample 

 1.5.1.1  The population of this study consisted of 138 1st year secondary 

vocational students, studying the Fundamentals of Computer Application course at 

Zigong Vocational and Technical School, Sichuan, China during the academic year 2022.  

 1.5.1.2  The research sample consisted of 10 1st year secondary vocationnal 

students who were selected using purposive sampling, studying the Fundamentals of 

Computer Application course at Zigong Vocational and Technical School, Sichuan, 

China.  

 1.5.2 Variables 

 In this research, there were independent and dependent variables. 

 1.5.2.1 The independent variable was the learning management through 

scaffolding. 

 1.5.2.2 The dependent variable was the learning achievement on the 

Fundamentals of Computer Application course. 

 1.5.3 Scope of Contents 

 The Fundamentals of Computer Application course for the experimental 

group of first-year secondary vocational students consisted of 8 academic hours, covering 

the following four topics: 
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 1) The composition of the computer system2 hours. 

2) Operation of Windows Operating System2 hours. 

3) Excel Spreadsheets2 hours. 

4) PowerPoint Basic functions and features 2 hours. 

 1.5.4 Scope of Time  

 The duration of this research project was from September 2022 to March 

2023. 

 

1.6  Definition of Terms 

 For ease of understanding, the following terms were conceptually and 

operationally defined as follows: 

 1.6.1  Scaffolding refers to analyzing the learning objectives and creating a 

supportive structure for learning. The learning management process includes situational 

creation, independent exploration, and collaborative learning. 

 1.6.2 The learning management through scaffolding provided a supportive 

structure for the construction of knowledge and technical skills, helping students to 

gradually establish and complete the required structure. Scaffolding teaching involves 

analyzing the learning objectives and creating a supportive structure for learning. The 

learning management process consists of five steps: 1) set up support, 2) enter thesituation, 

3) independent exploration, 4) collaborative learning, 5) impact assessment. 

 1.6.3  Learning achievement refers to the knowledge and skills acquired by 

students through the learning management process, including knowledge, memory, 

understanding, and application gained through scaffolding teaching. It was assessed 

through a test on the Fundamentals of Computer Application course. 

 1.6.4 Secondary vocational students are first-year students studying the 

"Fundamentals of Computer Application" course at Zigong Vocational and Technical 

School, Sichuan, China, during the academic year 2022. 
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1.7   Conceptual Framework 

 Since the research paper employed an experimental research design, the 

framework below served as the researcher's guide in the conduct of the study: 

 

 

 

 

 
 

 

Figure 1.1  Conceptual Research Framework 

 

1.8  Benefits 
 1.8.1 The study aimed to strengthen students' learning effectiveness and 

improve their learning achievement in Fundamentals of Computer Application course. 

 1.8.2 The study aimed to obtain innovative learning management through 

scaffolding teaching, which was expected to improve learning achievement. 

 1.8.3 The study aimed to provide guidelines for developing learning 

management innovation with scaffolding teaching for other subjects. 
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CHAPTER 2 

REVIEW OF THE LITERATURE 

 

 This chapter focuses on reviewing the previous studies related to the following 

areas relevant to this research. 

 2.1  Learning Management 

 2.1.1  Definition of learning management 

 2.1.2  Elements in learning management 

 2.1.3  Process of learning management 

 2.2 Scaffolding Teaching 

 2.2.1  Online teaching 

 2.2.2  Scaffolding the Learning Achievement teaching 

 2.2.3  Process of online scaffolding teaching 

 2.3  Learning Achievement 

 2.3.1  Definition of Learning Achievement 

 2.3.2  Learning achievement measured 

 2.4  Relevant Research 

 2.4.1  Domestic research 

 2.4.2  Foreign research 

 

2.1  Learning Management 

 2.1.1 Definition of learning management 

 In the past, learning management referred to the design and 

implementation of teaching methods, strategies, and plans aimed at enhancing the 

effectiveness of students' learning. It encompassed the integration of various elements, 

including communication, guidance, assistance, planning, group allocation, teaching 

materials, and teaching platforms, within teaching strategies and methods. The primary 

goal of teaching management was to develop a teaching plan that could effectively 

improve students' learning outcomes 

 According to Changwong et al. (2018, pp.37-48), learning management 

was a teaching process in which the teacher guided, organized, and assisted learners in 
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achieving improved learning outcomes, considering the content, characteristics, and 

objectives of the target course. Teachers adopted specific teaching modes that took into 

account the learners' existing knowledge, learning motivation, requirements, as well as 

the availability of teaching resources and environmental factors. Learning management 

played a crucial role in various levels of education and was commonly utilized in 

vocational training and internal employee training. 

 According to Zhao Jushan (2010, pp.23-25), efficiency and goal orientation 

were regarded as fundamental concepts in teaching management. Teachers had the ability 

to develop complementary teaching strategies, plans, and resources in order to enhance 

students' learning achievements. It was crucial for teachers to execute teaching 

management in accordance with the established plan and assess whether the expected 

goals were attained through students' learning outcomes. 

 Sun Yanhua (2019, pp.55-59) proposed that teaching management 

consisted of three elements: teaching concept, teaching management mechanism, and 

platform. Within the context of curriculum reform in Chinese universities, it was 

imperative to first shift the traditional teaching concept and incorporate new perspectives, 

theories, and pedagogical methods to innovate teaching management. Based on this 

foundation, teaching management activities could be enhanced by improving teaching 

materials, teaching tools, and relevant resources. Additionally, in light of the 

advancements in information technology, the comprehensive utilization of online and 

offline teaching platforms served as a crucial foundation for innovation in teaching 

management. 

 In the era of information technology, the advent of the Learning 

Management System (LMS) has offered convenient tools and platform support for 

teachers' learning management activities. With the assistance of information technology 

and these tools, online learning has emerged as an effective method for overcoming the 

geographical limitations inherent in traditional teaching activities. It has also opened up 

possibilities for innovative approaches to learning management. Online learning has 

enriched and diversified teaching and learning activities, expanded the range of available 

learning resources, and introduced new teaching models into learning management. 

Consequently, it has significantly broadened the scope and significance of learning 
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management. In this context, the integration of various teaching modes with online 

instruction has become a standard approach to learning management. 

 2.1.2 Elements in learning management 

 Teaching management involved the implementation of specific methods, 

strategies, and plans to attain teaching objectives. These elements served as prerequisites 

for the realization of effective teaching management and also served as crucial areas of 

focus for research in teaching management. 

 According to Lu Yuying (2019, pp.32-34), the key elements of Learning 

Management are as follows: 

 Teacher: The teacher played the role of the learning management leader 

and was responsible for formulating learning plans and programs, selecting teaching 

models, arranging learning resources and environments, facilitating learning activities, 

and assessing learning outcomes. 

 Students: Students actively engaged in learning activities under the 

guidance of the teacher, and their test scores served as a central criterion for evaluating 

the effectiveness and quality of learning management. 

 Course Content: The course content influenced the choice of teaching 

mode, learning resources, environmental arrangements, teaching plans, and assessment 

plans in learning management. Various course contents could result in specific variations 

in learning management approaches. 

 Teaching Mode: The teaching mode encompassed the specific teaching 

methods employed in course instruction. Teachers were required to adaptively choose the 

most appropriate teaching mode based on the content, characteristics, and requirements 

of the course, as well as the available teaching resources, learning environment, and the 

students' learning objectives. 

 Learning Environment: In learning management, the teaching activities 

of teachers and the learning activities of students relied on various resources, including 

learning materials and tools, which composed the learning environment. The learning 

environment imposed specific constraints on learning management. When selecting a 

particular teaching mode, teachers needed to take into account the elements of the 
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learning environment. The emergence of information technology has presented 

opportunities for online learning. 

 Luo Yingxia et al. (2020, pp.39-40) maintained that execution was the 

fundamental element of teaching management, with the focus being on the establishment 

of execution. The utilization of teaching resources, strategies, and methods entailed early-

stage planning, design, and resource integration, as well as the application of teaching 

management concepts and resources to specific teaching activities. Consequently, 

executive power played a pivotal role in teaching management. The difficulty of planning 

and designing teaching management had diminished thanks to the continuous 

development and innovation of educational theories and methods. At the core of teaching 

management lay the implementation and execution of teaching management schemes by 

teachers. 

 The aforementioned perspective was grounded in the elemental structure 

of the teaching management system. In traditional teaching management activities, 

teachers, students, courses, methods and modes, and the teaching environment constituted 

the core elements of teaching management. From the standpoint of teaching management 

implementation, the effective execution of teaching concepts, methods, models, and so 

on could also be considered a crucial element of teaching management. This encompassed 

how teachers could enhance the implementation of teaching programs and plans to 

achieve the desired outcomes. 

 2.1.3  Process of learning management 

 To achieve effective teaching management, several critical elements 

were necessary, and meticulous scientific planning and design were vital. As a result, the 

success of teaching management relied on the design of teaching plans, resource 

allocation, implementation of teaching plans, and evaluation and assessment of learning 

outcomes. 

 Waheeb et al. (2019, pp.232-238) discussed the process of learning 

management and outlined the following steps: 

 Step 1:  Drawing from their teaching experience, teachers determined the 

most suitable teaching mode based on the course content, student characteristics, teaching 

resources, and learning objectives.  
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 Step 2: Teachers designed and formulated the learning plan, incorporating 

elements such as teaching materials, class hours, learning progression, test questions, and 

more. This was done in accordance with the selected teaching mode and the overall 

requirements of teaching activities.  

 Step 3: Teachers organized and enhanced the teaching environment and 

resources in alignment with the learning plan.  

 Step 4:  Teachers and students actively engaged in the learning process, 

with the teacher facilitating and executing the teaching activities as outlined in the 

teaching plan. Students, in turn, pursued course learning and adhered to the teacher's 

guidance and requirements.  

 Step 5:  Based on the assessment of learning outcomes, the teacher 

reflected on and refined the teaching plan and implementation methods. This was done in 

response to the students' test results and feedback on learning management. 

 Luo Yingxia (2020, pp.39-40) asserted that execution was a distinct 

manifestation of the teaching management process. The execution of teaching 

management could be enhanced by incorporating essential elements such as teachers, 

courses, teaching resources, teaching methods, teaching platforms, and teaching 

environments. Hence, within the context of the specific teaching management process, 

teachers employed various methods in their teaching activities, drawing upon teaching 

resources, teaching platforms, and teaching environments to align with the curriculum's 

teaching objectives. Teachers adeptly planned and utilized diverse resources during the 

implementation stage and adjusted and refined the teaching management process in 

response to internal and external environmental factors. 

 The process of teaching management extended beyond mere resource 

integration and plan implementation. It necessitated teachers to possess extensive 

teaching experience, the ability to adaptively utilize various teaching methods in 

accordance with specific teaching objectives and students' individual circumstances, and 

to harness the value and potential of diverse teaching resources. It also involved 

maximizing the value of all teaching management elements from the students' 

perspective, with the aim of enhancing students' learning effectiveness through proper 

guidance. 
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2.2  Scaffolding Teaching 

 2.2.1 Online teaching 

                    Online teaching has emerged within the context of rapid advancements 

in information technology. It represents a contemporary teaching approach and system 

that combines traditional teaching methods with various information technologies and 

tools. More specifically, online teaching pertains to the process, mode, or method of 

instruction and learning facilitated through the application of information and Internet 

technology. 

                    According to Elizabeth et al. (2017, pp.80-86), online teaching representted 

a distinct teaching method rooted in web technology that differed from traditional face-

to-face learning. Its distinguishing feature lay in the remote participation of both teachers 

and learners in teaching and learning activities. Therefore, online teaching was a form of 

distance education reliant on network technology, tools, and platforms. Leveraging 

network technology, online teaching transcended geographical barriers, connecting 

teachers and learners and granting access to audio, video, slides, and other learning 

resources. Compared to traditional teaching, online teaching offered greater flexibility as 

learning resources and activities could be stored and accessed online. For instance, 

teachers could upload instructional videos to online learning platforms, enabling learners 

to engage with the material at their convenience, aligning with their schedules and 

learning plans. Furthermore, teaching and assessment activities could also be conducted 

online. 

                    Online teaching employed a range of methods and modes, such as one-

to-one video calls, group video calls, and webinars. The objective of both online and 

traditional offline teaching was to impart knowledge and enhance students' learning 

outcomes. However, online teaching placed a greater emphasis on the availability of 

diverse online learning resources, including online courseware and learning materials. It 

fully leveraged the advantages of information technology to present these resources in 

various formats, such as online videos, audio, animations, images, and text. Additionally, 

online teaching had the capacity to overcome geographical barriers and extend teaching 

activities to remote areas through virtual online learning spaces. 
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                        Online teaching necessitated the acquisition of computer, network, and 

other technical skills by both teachers and students. At that time, numerous online 

teaching platforms had emerged (Li Fang and Shi Yuxin, 2020, p.15), and it was 

imperative for teachers and students to familiarize themselves with the functionality and 

operational procedures of these platforms. 

  In the post-epidemic era, the significance of online teaching has become 

increasingly apparent. With the aid of network tools and platforms, online teaching has 

greatly broadened the scope of traditional offline classroom instruction, providing 

convenience for teachers and students to actively participate in teaching activities. 

Furthermore, online teaching has successfully extended its applications beyond academic 

education to non-academic fields such as training, exchanges, and discussions. Online 

learning has emerged as a teaching method of equal importance alongside offline 

teaching. 

 2.2.2 Scaffolding the Learning Achievement teaching 

 Scaffolding Teaching was a teaching mode that was developed based on 

the constructivist learning theory in the past. Its central focus revolved around students, 

with the objective of fostering their independent learning and problem-solving skills 

while progressively attaining the desired learning objectives through the guidance and 

support of teachers. 

 According to Hu Yunqi et al. (2019, pp.86-87), scaffolding teaching was 

a teaching mode that established a student-centered learning environment and activity 

plan under the guidance of teachers in the past. Through learning situations, team 

cooperation, and collaborative communication, teachers utilized the elements of the 

teaching environment to construct scaffolding based on the teaching content. This 

scaffolding was continuously developed throughout the progression of teaching activities, 

ultimately leading to the construction of meaningful knowledge. 

 The scaffolding teaching mode emphasized the idea of student-centered 

instruction and exerted notable effects in fostering students' practical problem-solving 

and self-directed learning abilities. In this mode, teachers were required to devise 

comprehensive teaching plans and provide students with step-by-step learning tips and 

cues, known as "scaffolding." Students made optimal use of these supportive elements to 
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acquire knowledge and resolve problems, ultimately attaining mastery of the teaching 

content and enhancing their practical problem-solving skills, as well as developing 

independent learning capabilities. 

 Scaffolding Teaching entailed teachers comprehending the concept of the 

Zone of Proximal Development and constructing scaffolding based on the current and 

potential development levels of individual and group students. This approach aimed to 

facilitate knowledge acquisition and foster overall progress (Li Yingfang et al., 2019, 

pp.13-15). 

 The commonly employed teaching methods in scaffolding included 

demonstration, explanation, association, student discussion, questioning, review, and 

others. During actual teaching, teachers were required to flexibly select appropriate 

teaching methods based on the content and objectives of the courses, as well as the 

individual differences among students. Scaffolding teaching demanded that teachers 

possess a more extensive theoretical knowledge base and a proficiency in understanding 

students' variations, enabling them to implement differentiated instruction (Yao Xiujuan, 

2019, pp.74-76). Overall, the scaffolding teaching mode was well-suited for courses that 

emphasized students' practical abilities and problem-solving skills. 

 2.2.3  Process of Online Scaffolding Teaching 

 Scaffolding teaching maximizes the benefits derived from constructivist 

learning theory by addressing the interplay between "teaching" and "learning," thereby 

transforming the teacher-student dynamic within instructional activities. Over time, it has 

evolved into a relatively well-established methodological system. The process of online 

scaffolding teaching encompasses the following steps (Zhou Yanhong, 2017, pp.10-12). 

 Step 1:  Initiate the educational scenario. The teacher employs the online 

learning environment, course content, and teaching objectives to guide students into the 

learning scenario. They introduce corresponding problem situations and provide 

additional tools and hints to facilitate problem-solving.  

 Step 2:  Establish support structures. Drawing upon the principles of the 

Zone of Proximal Development, the teacher aids students in constructing online scaffolds 

using teaching resources and tools aligned with the course content and teaching 

objectives.  
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 Step 3:  Independent student exploration. Following the completion of 

scaffold construction, students engage in independent exploration and research of 

problems through the internet and various information-based learning tools and 

platforms, utilizing the scaffolds provided by the teacher.  

 Step 4:  Online collaborative learning. Under the guidance of the 

teacher, students collaborate and share the outcomes of their individual independent 

learning and exploration within the group through online discussions, collectively 

working towards problem-solving. The teacher organizes students into online groups and 

facilitates internal discussions and negotiations within each group.  

 Step 5:  Assess learning outcomes. The learning effect and quality are 

comprehensively assessed by means of learner self-evaluation, group peer evaluation, and 

teacher evaluation. This assessment encompasses the learner's problem research and 

exploration process as well as standardized tests. 

 The combination of scaffolding teaching and online learning has inherent 

advantages. Information technology and tools can provide teachers with more abundant 

and convenient scaffolding building methods and strategies (Yang Rixin, 2019, pp.10-

13). Scaffolding teaching can also give full play to the advantages of online learning and 

provide more choices for communication and interaction between teachers and students, 

students, and students. 

 The fundamental process of online scaffolding teaching amalgamates the 

attributes of online teaching, including networking, distance, and interactivity, within the 

scaffolding teaching process. This integration optimizes their benefits and affords 

teachers and students a more efficient teaching approach, coupled with a relaxed and 

convenient learning environment. 

 

2.3  Learning Achievement 

 2.3.1 Definition of leanring achivement 

 Phairoj Kachentorn (2013, p.49) defines the leanring achivement as the 

characteristics, including knowledge and abilities, that result from education, teaching, or 

accumulated experiences that individuals have gained from learning. These factors lead 

to behavioral changes in various aspects of brain functionality.  
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 Sirisarn Sirithirin (2011, p.18) states that the meaning of learning 

outcomes refers to the academic achievement of individuals, which can be measured 

through various assessment methods that do not necessarily rely on testing. These 

methods include evaluating students' work and observing their behavior, among others. 

 Thawatchai Bunsawatkanchai (2000, p.4) defines learning outcomes as 

the knowledge, skills, and brain functionality in various aspects that students acquire from 

the instruction of teachers, which can be assessed using achievement tests. 

 Gagne (1985, p.40) stated in the past that Achievement Learning was 

divided into five aspects, namely intellectual ability, cognitive strategies, verbal 

information, attitudes, and skills. 

 According to Bloom in Suharsimi Arikunto (1990, p.110) that learning 

outcomes canbe divided into three aspects, namely cognitive, affective and psychomotor. 

 Learning achievement was defined in the past as the enhancement of 

students' knowledge structure, skill level, and overall competence through the utilization 

of diverse learning tools, methods, environments, materials, and practical training 

activities. This progress was achieved through self-learning, group learning, teacher 

guidance, assistance, coordination, and other instructional approaches. The extent of 

change in internal abilities and knowledge structures could be quantitatively measured 

using specific methods and tools. 

 2.3.2 Learning achievement measured 

 Yaoawadi Rangchaiakun Viboonsri (2008, p.16) stated in the past that 

the purpose of using achievement tests was to measure the learning outcomes in terms of 

subject content and various skills of each academic discipline, especially in multiple 

subjects taught at different grade levels in each school. 

 Uthumporn Chamraman (1998, p.1) explained in the past that assessing 

learning outcomes was the effort to evaluate whether students had achieved the intended 

goals of learning and teaching, as well as adhered to the content and instructional methods 

that teachers had arranged for the learning experiences. 

 1) Quantitative testing, which refers to a series of test questions 

designed to measure students' learning achievement based on their learning content and 



25 
 

goals through closed or open book methods. The measurement results are quantitative 

scores, and the level of test scores can largely reflect students' learning level and quality. 

 2) Non-quantitative tests, which usually referred to non-quantitative 

face-to-face tests, learning process assessments, etc., were conducted by teachers or other 

evaluators with students in a one-on-one manner after learning was completed. The 

purpose was to obtain students' various performances during the learning process and 

assess the degree of improvement in knowledge, skills, comprehensive qualities, and 

other aspects after learning. 

 3) Self assessment, which refers to the comprehensive evaluation of 

students' performance and final learning outcomes during and after the learning process. 

 4)  Group mutual evaluation was usually applied in situations where 

students learned in groups. Other students in the same group evaluated the students' 

performance in the learning process and the learning achievements obtained through the 

learning process. 

  In the research on methods of student learning achievement, Li Yingfang 

et al. (2019) believed that the measurement and evaluation of students' learning 

achievements should be adaptively chosen according to specific circumstances, with a 

primary emphasis on various quantitative assessments. Han Xiao (2019) believed that the 

evaluation of students' learning achievement relied on several crucial factors, including 

evaluation objectives, evaluation environment, evaluation methods, evaluation tools, 

evaluation resources, evaluation subjects, and evaluation objects.  Among these factors, 

the evaluation objectives and evaluation environment play a pivotal role in determining 

the selection and implementation of the other elements. 

 

2.4  Relevant Research 

 2.4.1 Domestic research 

 According to Li Yi (2010), scaffolding teaching has witnessed increasing 

utilization in modern distance online education. Distance online education offers a 

convenient implementation environment and application space for the implementation of 

scaffolding teaching. Teachers have the opportunity to create scaffolding through goal 

guidance, skill instruction, exploration methods, and evaluation mechanisms. They can 



26 
 

design and execute teaching plans tailored to learners' characteristics and needs, 

conducting teaching activities via online learning tools and platforms. Throughout this 

process, teachers are required to possess higher quality and abilities, including experience 

in course teaching, proficiency in scaffolding teaching, and expertise in utilizing various 

distance online teaching tools and platforms. 

 The implementation of online scaffolding teaching has demonstrated 

significant advantages over the traditional classroom teaching mode in various aspects. 

These include students' enhanced learning enthusiasm, increased concentration, improved 

critical thinking abilities, heightened collective consciousness, and enhanced reflective 

capabilities. Moreover, students' test scores have shown improvement as well. 

 Wang Huijun et al. (2021) conducted research, designed, and executed 

an online scaffolding teaching plan for the "Information Technology Course and 

Textbook Analysis for Primary and Secondary Schools" using teaching cases and Wiki 

services on the blackboard platform. 

 Yang Ping (2020) conducted research on integrated scaffolding teaching 

and flipped classrooms and implemented it in the teaching of information technology at 

a university in China. Through the design, establishment, and implementation of the 

flipped classroom teaching mode and scaffolding teaching scheme, this teaching mode 

exhibited significant advantages in addressing issues such as students' lack of enthusiasm 

for independent learning, limited engagement in teaching activities, and reduced learning 

efficiency when compared to a simple online teaching mode. The author provided 

comprehensive suggestions and activity frameworks for the implementation process, 

encompassing specific teaching scheme design and scaffold construction. 

 Luo Li (2020) conducted research on the rapid growth of online 

education in China in light of the COVID-19 pandemic. The investigation revealed that 

the majority of online teaching in China exhibited relatively low effectiveness and 

quality, with notable issues such as limited student participation, diminished learning 

enthusiasm, and reduced learning efficiency. Consequently, based on the inherent 

characteristics and prevalent challenges of online teaching, the author conducted practical 

research on the information technology course in senior high school. The study found 

that, within the online teaching environment, the scaffolding teaching mode showcased 
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significant advantages. These included offering personalized and targeted teaching 

programs for students, enhancing their self-directed learning abilities, stimulating their 

interest in learning, and promoting active classroom participation. 

 Han Xiao (2019) conducted research on the application of the scaffolding 

teaching mode in online College English courses in the past. The study involved 

implementing SMRT teaching method practice activities at Harbin Guangxia University. 

The SMRT teaching method was an English teaching approach that utilized the Internet, 

web technology, and mobile devices, employing the scaffolding teaching mode and 

online learning software. According to the research findings covering the period from 

2016 to 2019, the SMRT teaching method exhibited significant improvements in college 

students' English proficiency. Test scores in oral English, reading, and writing surpassed 

those achieved through traditional English classroom teaching methods. 

 2.4.2 Foreign Research 

 Suwastini et al. (2021) held the belief that online teaching would be the 

future trend in modern society. They also recognized the significant achievements of 

scaffolding teaching in enhancing student progress in traditional offline teaching. 

Therefore, conducting research to adjust and refine scaffolding teaching in the online 

teaching mode was deemed highly important. The study examined the specific methods, 

contents, types, and characteristics of scaffolding teaching within the framework of online 

teaching, utilizing academic information platforms such as ERIC, Google Scholar, and 

ResearchGate as supportive databases. The research identified key elements of 

scaffolding teaching under the online teaching framework, including the provision of 

learning opportunities, addressing waning learning enthusiasm, and the transfer of 

teachers' responsibilities. The study proposed optimizing and enhancing the procedures, 

concepts, primary activities, and teaching strategies within the scaffolding teaching 

process to address these issues. Specific measures encompassed positioning the content 

and structure of course materials within the online environment, facilitating remote access 

to digital educational resources and teaching tools, cultivating students' critical thinking 

skills, providing guidance and assistance in practical problem-solving processes, 

incorporating digital teaching cases and knowledge points, and establishing a constructive 

teaching feedback mechanism. 
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 Atipat and Thiadporn (2019) conducted research on the utilization of 

scaffolded instructions to enhance students' speaking skills and bolster their confidence. 

The study involved twelve first-year undergraduate students who participated in a self-

study club called "Let's Speak." The club aimed to empower students to deliver effective 

presentations and speak English with confidence. Throughout ten sessions, students 

engaged in practice sessions focused on five different topics, with each topic being 

practiced for two weeks. Language support and feedback from teachers and peers were 

provided as scaffolds to enhance students' performance on a weekly basis. To evaluate 

changes in their perceived confidence, the researchers administered a confidence in 

speaking questionnaire (adapted from Griffee) to the participants before the first session 

and after the tenth session. Additionally, the researchers compared the checklist and 

presentation scores from the initial and final sessions to measure overall performance 

changes. At the conclusion of the tenth session, the students watched videos of their 

performances from the first and tenth sessions and participated in a stimulated-recall 

interview to reflect on their progress. The findings indicated an increase in students' 

perceived confidence, higher scores in their actual performance, and self-reported 

improvements in various aspects. The paper discussed pedagogical implications and 

provided suggestions based on these findings. 

 Yee Ling Lee and Meng Yew Tee (2021) conducted research in the past 

on the scaffolding strategies employed by facilitators in a design-based learning (DBL) 

context. DBL was an inquiry-based pedagogy that focuses on generating artifacts to 

address real-life issues through an iterative engineering design process. However, 

completing design tasks can be challenging, necessitating scaffolding to support student 

learning in a DBL setting. A literature review revealed significant implementation issues 

related to scaffolding student learning in this context, and the roles of facilitators in 

scaffolding student learning in a DBL context were under-researched. This study aimed 

to investigate facilitators' scaffolding strategies that could aid students in integrating 

knowledge within a DBL context. 

 The study involved a class of 27 Form 1 students in a national school 

who were assigned the task of designing and constructing a water filter while integrating 

knowledge from Science, Technology, Engineering, Arts, and Mathematics (STEAM) 
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subjects. The facilitator provided scaffolding throughout the implementation of this 

design task, and data were collected through video recordings, student interviews, and 

researcher's notes. The research findings demonstrated that the facilitator utilized various 

scaffolding strategies to support student learning based on their emerging learning needs. 

These scaffolding strategies were categorized into six types, including cognitive, 

linguistic, metacognitive, motivational, social, and strategic scaffolding. This study shed 

light on the multiple roles played by facilitators in scaffolding student learning in a DBL 

context, emphasizing the importance of incorporating diverse scaffolding strategies to 

enhance student learning outcomes. 

 In a separate study, Quang Nhat Nguyen (2022) conducted research on 

teachers' scaffolding strategies in internet-based English language teaching (ELT) 

classes. The COVID-19 pandemic necessitated social distancing measures, leading to the 

widespread adoption of internet-based ELT in developing countries. However, the sudden 

shift from face-to-face to online learning raised concerns about maintaining the quality 

of ELT education during crises, specifically regarding how teachers scaffolded students 

in internet-based classrooms. While significant research has focused on scaffolding 

students' learning in face-to-face ELT classes, effective scaffolding strategies for online 

classes warranted further scholarly investigation. 

 This article provides a review of contemporary research on scaffolding 

strategies for teachers to implement in their internet-based ELT classes. The author 

synthesizes and systematizes scaffolding functions, intentions, and strategies that can be 

applied in internet-based English classes, offering practical recommendations for teachers 

to scaffold students in diverse online teaching and learning contexts. Additionally, the 

article addresses common challenges and proposes solutions for teachers to effectively 

employ scaffolding strategies in internet-based ELT classrooms. 

 Based on the research findings of both domestic and international 

scholars, the scaffolding teaching mode has emerged as an important approach for 

implementing constructivism theory in specific teaching practices. Scaffolding teaching 

offers students the necessary conditions for autonomous learning and self-improvement 

with the guidance and support of teachers. As online education technology and theories 

continue to advance, integrating the scaffolding teaching mode with online teaching 
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technology not only leverages the benefits of scaffolding teaching but also overcomes the 

limitations of physical teaching spaces. This integration provides a more convenient and 

supportive environment for implementing the scaffolding teaching mode. 

Given these considerations, the researcher was motivated to investigate the 

potential of scaffolding teaching in enhancing learning management and improving 

learning achievements among first-year secondary vocational students. 

 

 

 

 



CHAPTER 3 

RESEARCH METHODOLOGY 

 

 The research on the learning management through scaffolding teaching to 

improve learning achievement for 1st year of secondary vocational students had the 

following details or components: 

 3.1  Research Design 

 3.2  Population and Sample 

 3.3  Research Instrument 

 3.4  Instrument Development 

 3.5  Data Collection 

 3.6  Data analysis 

 3.7  Statistics used in Research 
 

3.1  Research Design 

 The study's design was quasi-experimental research, and the experimental 

design used was the one-group pretest-posttest design. 

 

Table 3.1  The One-Group Pretest-Posttest Design 

Pre-test Independent variable Post-test 

T1 X T2 

 
 

 Symbols Used in experimental design 

 X = learning management through scaffolding teaching on the  

   Fundamentals of Computer Application courses 

 T1 = Pre-test  

 T2 =  Post-test  
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3.2  Population and Sample 

 3.2.1 Population 

 The population of this study consisted of 138 1st year secondary 

vocational students, studying the Fundamentals of Ccomputer Application course at 

Zigong Vocational and Technical School, Sichuan, China during the academic year 2022. 

 3.2.2  Sample 

 The research sample consisted of 10 1st year secondary vocational 

students who were selected using purposive sampling method, studying the Fundamentals 

of Computer Application course at Zigong Vocational and Technical School, Sichuan, 

China. 

 

3.3  Research Instrument 

 The research instruments were classified into the types used in the experiment 

and the instruments used for data collection. With details as follows:  

 3.3.1 The learning management plan for the Fundamentals of Computer 

Application course using scaffolding teaching consisted of 8 academic hours for the 

experimental group of 1st year secondary vocational students. The course content covered 

four topics, with each topic having 2 hours dedicated to it: 

 1)  Composition of the computer system 

 2)  Operation of Windows Operating System 

 3)  Excel Spreadsheets 

 4)  PowerPoint Basic functions and features 

 3.3.2  The test of the learning achievement for the Fundamentals of Computer 

Application course included a test paper with 30 multiple-choice questions. 

 

3.4  Instrument Development  

 3.4.1 The learning management plan for the Fundamentals of Computer 

Application course using scaffolding teaching was developed with the following steps for 

instrument development: 

 3.4.1.1 The researchers collected and analyzed relevant documents and 

research papers to explore and analyze the learning management through scaffolding 
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teaching for first-year secondary vocational students in the Fundamentals of Computer 

Application course. They studied relevant concepts, theoretical systems, and methodology  

of learning management through scaffolding teaching. The new teaching mode aims to 

strengthen students' subjective initiative in learning, optimize the teaching objectives of 

the course, improve the effectiveness of students' independent learning, and enable 

students to quickly overcome difficult points of knowledge learning. The process of 

scaffolding teaching includes the following steps, as identified by Zhou Yanhong (2017, 

pp.10-12). 

 

Table 3.2  The learning management process of scaffolding teaching 

Steps The learning management process of scaffolding teaching 

Step 1 Entering the educational situation involved using the network 

environment and teaching course content and objectives to guide 

students into the learning situation. The teacher assisted students in 

understanding the problem situation and provided additional tools 

and clues to help solve the problems. 

Step 2 The teacher built the support by utilizing online teaching 

resources and tools to help students construct scaffolds based on the 

theory and basic requirements of the nearest Development Zone in 

accordance with the course content and teaching objectives. 

Step 3 Students were expected to explore independently after the 

scaffold construction was completed. They conducted independent 

research and exploration on problems through the network and 

various information-based learning tools and platforms. This was 

achieved through online self-learning in accordance with the 

scaffold built by the teacher. 
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Table 3.2  The learning management process of scaffolding teaching (Cont.) 

Steps The learning management through the direct instruction model 

Step 4 Online collaborative learning involved teachers, students, and 

peers sharing the results of their independent learning and 

exploration within the group through online discussions. They 

worked together to solve problems encountered during online 

learning, under the guidance of the teacher. The teacher grouped 

learners online and facilitated internal discussions and negotiations 

within each group. 

Step 5 Evaluation of learning outcomes was conducted by 

comprehensively assessing the learner's performance and quality 

throughout the problem research and exploration process, as well as 

standardized tests. The evaluation process included learner self-

evaluation, group mutual evaluation, and evaluation by the teacher.. 

 

 3.4.1.2 The teaching content and ideas were determined, and an online 

scaffolding teaching environment for the Fundamentals of Computer Application course 

was established on the UMU platform, targeting 1st-year secondary vocational students.

 3.4.1.3 The learning management plan with learning management 

through the scaffolding teaching on the Fundamentals of Computer Application course 

was created. The learning management contents included: 

 1)  Composition of the computer system 

 2)  Operation of Windows Operating System 

 3)  Excel Spreadsheets 

 4)  PowerPoint Basic functions and features 

 3.4.1.4 The learning management plan with learning management 

through the scaffolding teaching on the Fundamentals of Computer Application course 

was proposed to the thesis advisor to verify the validity of the content and suggestions. It 

was revised based on suggestions. 
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 3.4.1.5 The learning management plan with learning management 

through the scaffolding teaching on the Fundamentals of Computer Application course 

was proposed to 5 experts, including 2 technology experts, 2 curriculum and instructional 

experts, and 1 measurement and evaluation education expert. The experts checked the 

correctness and consistency of the learning management plan elements, including 

learning objectives, learning contents, learning management process, learning materials, 

and measuring learning outcomes. The scoring criteria were as follows: 

 Score 1:  Ensure the elements of the learning management plan 

are consistent. 

 Score 0: When unsure that the elements of learning management 

plan are consistent. 

 Score-1: When sure that the elements of learning management 

plan are not consistent. 

 3.4.1.6 The analysis results of the item objective consistency (IOC) 

were considered, selecting items with a score of 0.05 or higher, and revised according to 

expert suggestions before the try-out. The analysis results showed that the IOC value was 

between 0.80-1.00.  

  3.4.1.7 The learning management plan with learning management 

through the scaffolding teaching on the Fundamentals of Computer Application course 

was tried out with 1st-year secondary vocational students in Zigong Vocational and 

Technical, China, who were not part of the sample of 1 classroom. 

 3.4.1.8 The learning management plan with learning management 

through the scaffolding teaching on the Fundamentals of Computer Application course 

was improved before data collection. 

  3.4.1.9  Data was collected with the learning management plan with 

learning management through the scaffolding teaching. 

 3.4.2 The learning achievement test on the Fundamentals of Computer 

Application course consisted of 30 multiple-choice questions. The steps taken to develop                  

the instrument were as follows: 
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 3.4.2.1 The researchers studied the related concepts and theories of 

quantitative tests and the methods of creating learning achievement tests. 

 3.4.2.2 The learning objectives and contents on the Fundamentals of 

Computer Application course were analyzed to create the learning achievement test. 

 3.4.2.3 The researchers created the learning achievement test on the 

"Fundamentals of Computer Application course", which included 40 multiple-choice 

questions. 

 3.4.2.4 After creating the learning achievement test on the Fundamentals 

of Computer Application course, the researchers proposed it to the thesis advisor to verify 

the validity of the content and suggestions. The test was revised based on the advisor's 

suggestions. 

 3.4.2.5 The researchers then proposed the learning achievement test on the 

Fundamentals of Computer Application course to 5 experts, including 2 technology experts, 

2 curriculum and instructional experts, and 1 measurement and evaluation education expert. 

The experts checked the correctness and consistency of the exam items and learning 

objectives. The scoring criteria were as follows:  

   Score 1: When the item of the exam was sure to be congruent 

with the learning objectives    

 Score 0: When unsure that the item of the exam was congruent 

 with the learning objectives 

 Score -1:  When sure that the item of the exam was not congruent  

  with the learning objectives 

 3.4.2.6 The analysis results of item objective consistency (IOC) were 

obtained by considering the compliance index, selecting items with a score of .05 or higher, 

and revising according to the expert suggestions before trying it out. The analysis results 

showed that the IOC value was between 0.80-1.00. 

 3.4.2.7 The learning achievement test on the "Fundamentals of Computer 

Application course" was then tried out with the 1st year of secondary vocational students at 

Zigong Vocational and Technical School, Sichuan, China, who were not a sample of                          

1 classroom. 
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 3.4.2.8 Difficult items were identified, and the quality criteria of the 

learning achievement test were specified with a difficulty level of 0.20 - 0.80 and a 

discriminating power from 0.20 - 1.00. 30 quality items were selected for the test. The 

analysis results showed that the test had a difficulty level of 0.40 - 0.80 and a discriminating 

power from 0.50 - 0.80.  

 3.4.2.9 The total reliability confidence value (Reliability) of the learning 

achievement test was analyzed by Cronbach's alpha coefficient (α). The analysis results 

showed that the total confidence value of the test was 0.972. 

  3.4.3.10 The researchers improved and published a learning achievement 

test that had passed the quality check and was used for data collection. 

 

3.5  Data Collection 

 The data collection process was carried out in the following steps: 

 3.5.1 Preparation steps 

3.5.1.1 The researchers contacted the graduate official at the Faculty of 

Technical Education, Rajamangala University of Technology Thanyaburi to request 

permission to collect data with a sample from the secondary vocational school in Zigong, 

China. 

 3.5.1.2 The researchers also contacted the director of the secondary 

vocational school in ZigongVocational and TechnicalSchool, China, to seek assistance 

and cooperation in collecting data from the sample. 

3.5.1.3  Using random cluster sampling, the researchers selected a 

sample of 10 first-year secondary vocational students from a total of 138 students in 

Zigong Vocational and TechnicalSchool, China. They explained the learning objectives 

and process of learning management through scaffolding teaching to the selected students 

to ensure that they understood their roles and responsibilities in the learning management. 

 3.5.2 Data collection steps 

 3.5.2.1 Prior to the learning management, the researchers administered 

a pretest to 10 first-year secondary vocational students in Zigong Vocational and 

Technical School, China. 
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3.5.2.2  The researchers collected data through learning management 

using scaffolding teaching on the Fundamentals of Computer Application course. 

 3.5.2.3  After the learning management, the researchers administered a 

posttest to 10 first-year secondary vocational students at Zigong Vocational and 

Technical School, Sichuan, China. 

 3.5.3 Summary steps  

 3.5.3.1 The researchers analyzed the scores using basic statistics and 

statistics used in hypothesis testing.  

 3.5.3.2 They summarized the data in tabular form, described the 

research findings, and discussed them. 

 

3.6  Data Analysis 

 In the data analysis, the researcher conducted the following data analysis steps: 

 3.6.1 Analysis of study instrument quality  

 3.6.1.1 The Index of Item Objective Congruence (IOC) was used to 

analyze the effectiveness of learning management plan. 

 3.6.1.2 The Index of Item Objective Congruence (IOC) was used to 

analyze the effectiveness of the learning achievement test on the Fundamentals of 

Computer Application course course. 

 3.6.1.3 The Cronbach Alpha Coefficient (α formula) was used to assess 

the reliability of the learning achievement test on the "Fundamentals of Computer 

Application course " with a confidence assessment of the alpha coefficient. 

 3.6.1.4 The difficulty of the learning achievement test on the 

Fundamentals of Computer Application course was analyzed, with a passing threshold 

set between 0.20 to 1.00. 

 3.6.1.5 The discriminating power of the learning achievement test on 

the Fundamentals of Computer Application course was analyzed, with a minimum value 

set at 0.20. 
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 3.6.2 Analysis used in hypothesis testing 

 3.6.2.1  The one-sample t-test was used to compare the learning 

achievement of 1st year secondary vocational students studying the Fundamentals of 

Computer Application course through online scaffolding teaching, whose score reached 

the 70 percent criteria. 

 3.6.2.2 The dependent samples t-test was used to compare the learning 

achievement of 1st year secondary vocational students on the Fundamentals of Computer 

Application course before and after the study through online scaffolding teaching. 

 

3.7  Statistics used in Research 

 3.7.1 Basic statistics 

 The researcher used descriptive statistics such as mean and standard 

deviation to analyze the data gathered from the experimental units primarily. 

3.7.1.1 Mean 
 

x�   =  
∑ x
N

 

     

    x� =  refers to the mean  

    ∑ x =  is the summation of all observations 

    N =  is the number of observations 

3.7.1.2 Standard Deviation 
 

x�   =  
∑ (x-x�) 2

n-1
 

   

    𝑥𝑥 − x� =   was the difference between the observation    

      (score) and the mean of the distribution 

    (x-x�) 2 =  was the squared deviation of the scores from  

      the mean 

    𝑛𝑛 − 1 =  was the number of observations minus the 1 
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 3.7.2 Statistics used in quality inspection of tools 

 3.7.2.1 Index of item Objective Congruence (IOC)  
 

IOC = 
∑R
N

 

 

    IOC =    was the Item Objective Congruence Index 

    ∑R =    was the summation of 1 in all raters  

    N =     was the number of items    

  3.7.2.2 Reliability (Cronbach Alpha Coefficient) 
 

∝  =
k

k-1 �1-
∑ si

2

si
2 � 

     

    ∝ =    was the Cronbach alpha coefficient 

    k =  was the number of items  

    ∑ si
2 =  was the sum of the variances of each item 

    si
2 =  was the variance of the total column 

 3.7.2.3 Difficulty  
 

P   = 
𝑅𝑅
𝑁𝑁

 

 

P = Difficulty index of an item 

R = Number of correct answers to item 

N = Number of correct answers plus the number of   

   incorrect answers to item 

 3.7.2.4 Discriminating power 
 

  B = 
𝑈𝑈
𝑛𝑛1
− 𝐿𝐿

𝑛𝑛2
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B = Discriminating Index 

 U = Correct answer in the upper group 

 L = Correct answer in a lower group 

 𝑛𝑛1 = No. of the examinee in upper  

 𝑛𝑛1 = No. of the examinee in the lower 

 3.7.3 Statistics used in hypothesis testing 

 3.7.3.1 The one-sample t-test was used to compare the mean of the 

learning achievement of 1st year secondary vocational students on the Fundamentals of 

Computer Application course who studied through online scaffolding teaching. The 

difference between the actual and hypothetical means was divided by the standard 

deviation of 70 percent.    

 3.7.3.2 The dependent samples t-test (also known as the paired t-test or 

paired-samples t-test) was used to compare the means of the learning achievement of the 

1st year of secondary vocational students on the Fundamentals of Computer Application 

course before and after studying through online scaffolding teaching, to determine 

whether there was a statistically significant difference between these means.   
 

                             t = ∑D

�n∑D2-(∑D)2

n-1

  

 

∑D  = Sum of the differences 

∑D2 = Sum of the squared differences 

(∑D)2 = Sum of the squared differences, squared 

 

 

 

 



CHAPTER 4 

RESEARCH RESULTS 

 

 The study the learning management though the scaffolding teaching to improve 

learning achievement for 1st year of secondary vocational students. The objectives to 

answer the following: 1) to compare the 1st year of secondary vocational students learning 

achievement on the Fundamentals of Computer Application course studying through the 

online scaffolding teaching whose score reached 70 percent, and 2)to compare the 1st year 

of secondary vocational students learning achievement on the Fundamentals of Computer 

Application course before and after studying through the online scaffolding teaching. This 

section will also present the following: 

 4.1 The comparative results of students’ learning achievement who studied 

through scaffolding teaching and reached the score criteria of 70%. 

 4.2 The comparative results of the student’s learning achievement before and 

after studying through scaffolding teaching. 

 

4.1 The comparative results of students’ learning achievement who studied through 

scaffolding teaching and reached the score criteria of 70%. 

 The results compared the learning achievement of the 1st year of secondary 

vocational students on the Fundamentals of Computer Application course studying 

through the online scaffolding teaching, with a criteria of reaching a score of 70 percent. 

This section also presents Table 4.1 and Figures 4.1. 

 

Table 4.1 The results of the student’s learning achievement studying through 

scaffolding teaching. 

Number of  

Students 

Learning management through scaffolding teaching 

Before Study After Study 

Score Percent (%) Score Percent (%) 

1 16 53.33 26 86.67 

2 14 46.67 25 83.33 
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Table 4.1  The results of the student’s learning achievement studying through 

scaffolding teaching. (Cont.) 

Number of  

Students 

Learning management through scaffolding teaching 

Before Study After Study 

Score Percent (%) Score Percent (%) 

3 14 46.67 28 93.33 

4 13 43.33 30 100.00 

5 13 43.33 29 96.67 

6 13 43.33 28 93.33 

7 15 50.00 27 90.00 

8 15 50.00 26 86.67 

9 15 50.00 26 86.67 

10 13 43.33 26 86.67 

Mean (x�) 14.16 47.00 27.10 90.33 

S 1.101  1.595  

 

Figure 4.1  The students' learning achievement studying through the online scaffolding  

teaching. 

 From Table 4.1 and Figure 4.1, the results reveal that the before-study test scores 

of students studying through scaffolding teaching were (x� =14.16, S=1.101) 47%, and the 

after-study test scores were (x� =27.10, S=1.595) 90.33%. 
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Table 4.2  The results of the comparison of students' learning achievement who studied 

through scaffolding teaching and achieved a score of 70 percent criteria. 

Learning 

management through 

scaffolding teaching 

(Number 

of Units) 

n 

Mean 

(x�)  

Standard 

Deviation 

(s) 

% of 

Mean 

t Sig. 

(1-tailed) 

After Study 10 27.10 1.595 54.20 -15.66* 0.000 

  

 The results from Table 4.2 revealed that the post-study test scores of students 

who studied through scaffolding teaching were 90.33% (x�  =27.10, S=1.595). When 

comparing the students' learning achievements through scaffolding teaching, it was found 

that their achievements were significantly higher than the 70% criterion at a statistical 

significance level of .05. 
  

4.2 The comparative results of the student’s learning achievement before and after 

studying through scaffolding teaching. 

The results compare the 1st year of secondary vocational students learning achievement 

on the Fundamentals of Computer Application course between the before and the after study 

through the online scaffolding learning management. This section will also present Table 4.3. 
 

Table 4.3  The comparative results of the student’s learning achievement before and 

after studying through scaffolding teaching. 

scaffolding 

teaching 

(Number 

of Units) 

n 

Mean 

(x�)  

Standard 

Deviation 

(s) 

Computed 

t-value                 

(t) 

Degrees of 

Freedom                    

(df) 

Sig. 

(p-value) 

Before Study 10 14.10 1.101 
17.103* 9 0.000 

After Study 10 27.10 1.595 
 

 From Table 4.3, the results reveal that the after-study test scores of students 

studying through scaffolding teaching were higher (x�=27.10, S=1.595) than the before-

study test scores (x�=14.10, S=1.101). When comparing the student’s learning achievement 

studying through scaffolding teaching, it was found that the after-study scores were 

significantly higher than the before-study scores at the statistical significance level of .05.  



CHAPTER 5 

CONCLUSION AND RECOMMENDATIONS 

 

 The study the learning management though the scaffolding teaching to improve 

learning achievement for 1st year of secondary vocational students. The objectives to 

answer the following: 1) to compare the 1st year of secondary vocational students learning 

achievement on the Fundamentals of Computer Application course studying through the 

online scaffolding teaching whose score reached 70 percent, and 2) to compare the 1st 

year of secondary vocational students learning achievement on the Fundamentals of 

Computer Application course before and after studying through the online scaffolding 

teaching. The research sample consisted of 10 1st year vocational secondary students 

studying the Fundamentals of Computer Application course at Zigong Vocational and 

Technical School, Sichuan, China, during the academic year 2022, selected through 

cluster sampling. The research instruments included a learning management plan based 

on scaffolding teaching and a learning achievement test. Mean, percentage, standard 

deviations, and t-tests were utilized for data analysis. 

 

5.1  Conclusion of Research Results 

 5.1.1  The comparative results of the student’s learning achievement studying 

through scaffolding teaching whose score reached 70 percent criteria.   

  The results revealed that the after studying test scores of students studying 

through scaffolding teaching were 90.33% (x�  =27.10, S=1.595). When comparing the 

student’s learning achievements studying through scaffolding teaching, it was found that 

the student’s learning achievements were higher than the 70% criteria with statistical 

significance at the.05 level. 

 5.1.2  The comparative results of the student’s learning achievement before and 

after studying through scaffolding teaching.  

   The revealed that after studying test scores of students studying through 

scaffolding teaching were (x�=27.10, S=1.595) higher than the before (x�=14.10, S=1.101). 

When comparing the student’s learning achievement studying through scaffolding 
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showed that the after-study scores were higher than the before-study scores statistically 

significant difference at the level of .05. 

   

5.2  Discussion and Recommendation 

 5.2.1  The comparative results of students' learning achievement, who studied 

through scaffolding teaching and achieved a score of 70 percent or higher, showed 

statistically significant improvement at the 0.05 significance level. This can be attributed 

to the student-centered teaching approach emphasized in scaffolding teaching, which has 

a noticeable impact on fostering students' practical problem-solving abilities and 

autonomous learning skills. In scaffolding teaching, teachers develop comprehensive 

teaching plans and provide students with step-by-step learning tips and guidance (Wang 

Liqun, 2021, pp.183-185). Laetitia (2020, pp.157-173) conducted a study on the 

application of scaffold teaching in computer education and found that scaffolding 

teaching involves the systematic construction of support structures for students under the 

guidance of teachers. As students gradually develop their capacity for independent exploration, 

the scaffolding was gradually removed. This approach highlights both the guidance provided by 

teachers and the gradual reduction of teacher guidance during the implementation process. The 

ultimate goal was to help students become more proficient in independent exploration, 

comprehension, and information construction, shifting the learning process from a teacher-

centered approach to a learner-centered one. Elizabeth et al. (2017, pp.80-86) conducted a study 

on online computer education courses based on scaffolding teaching theory. They found that 

scaffolding teaching creates a conceptual framework for students' knowledge acquisition within 

their zone of proximal development. This allows students to construct meaning through social 

interactions while solving task problems, gradually acquiring new knowledge and mastering skills 

within their potential development. By creating scaffolding within the students' nearest 

development zone, teachers assist students in bridging the gap and reaching their potential 

development levels during the teaching process. Scaffolding teaching was particularly suitable 

for courses that emphasize practical abilities and problem-solving skills (Luo Li, 2020, pp.243-

245).  Dar et al. (2019, pp.79-92) confirmed the effectiveness of scaffolding teaching, as students 

exposed to the scaffolding strategy outperformed their counterparts who were taught using 

traditional methods. This explains why the students in the study achieved scores higher than the 

70 percent threshold. 
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 The comparative results of students' learning achievement before and after studying 

through scaffolding teaching revealed that the students' post-learning achievement, after being 

exposed to scaffolding teaching, was significantly higher than their pre-learning achievement at 

the 0.05 significance level. This improvement can be attributed to the use of scaffolding in 

teaching, as students' academic performance significantly increased compared to their previous 

performance. Therefore, scaffolding teaching has a significant positive impact on students' 

academic performance. Scaffolding teaching involves breaking down the curriculum knowledge 

into basic elements necessary for teaching activities and providing students with corresponding 

tools and structural support to learn the fragmented knowledge with the guidance and assistance 

of teachers (Lu Yuying, 2019, pp.32-34).  In the context of information technology classroom 

teaching, the application of scaffolding teaching has transformed the traditional teaching methods, 

placing students at the center and promoting their construction of a knowledge framework. In the 

classroom, students shift from passive knowledge recipients to active knowledge seekers, 

enhancing their learning enthusiasm through collaborative learning and inquiry activities. 

Teachers have transitioned from being the leaders of classroom teaching to observers of student 

learning, assisting students in completing exploratory learning and fostering students' confidence 

in their own learning. This transformation in teaching forms has allowed every student to 

participate in classroom learning, providing them with more opportunities for learning (Wang 

Lixin, 2021, pp.19-20). Consequently, through the implementation of scaffolding teaching, 

students' scores in the Basic Computer Application course have significantly improved, 

surpassing their previous performance. 

 

5.3  Implication for Practice and Future Research 

 5.3.1  Suggestions for applying the research results. 

 5.3.1.1 The application of scaffolding teaching has had a positive 

impact on the current teaching situation of the "Computer Application Foundation" course 

in secondary vocational schools, as evident in the following aspects: Firstly, within the 

teaching process, teachers effectively engage students and enhance their focus on learning 

by incorporating relatable scenarios that resonate with students with new knowledge to 

be acquired. This stimulates students' interest in learning and creates an engaging learning 

environment. Secondly, during the process of autonomous exploration, students are 

assigned a series of small learning tasks by the teacher, which helps them enhance their 

self-ability and develop essential skills. Additionally, in collaborative learning activities 
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conducted in groups, students not only learn from each other but also enhance their 

language expression and cooperation skills. In conclusion, compared to traditional 

teaching methods, the implementation of scaffolding teaching in the "Fundamentals of 

Computer Application" curriculum in secondary vocational schools effectively improves 

students' academic performance, thus confirming the experimental hypothesis. 

 5.3.1.2  The implementation of scaffolding teaching yielded positive 

results in enhancing the classroom teaching effectiveness of the "Computer Application 

Foundation" course in secondary vocational schools. Despite the initial weak basic 

knowledge and abilities of students in computer application, the provision of timely and 

appropriate learning scaffolds facilitated deeper understanding and mastery of new 

knowledge, thereby improving their learning effectiveness and performance. Furthermore, 

through the analysis of assigned learning tasks and post-class work quality, it was evident 

that students had successfully acquired and applied the content covered in class.A comparison 

between the experimental group and the control group, in terms of classroom learning quality 

and final test scores, clearly demonstrated the improved learning ability and efficiency of 

students in the experimental group. Their proficiency in mastering knowledge points and 

application abilities in the "Fundamentals of Computer Application" course surpassed that of 

the control group. 

 5.3.1.3 The implementation of scaffolding teaching in secondary 

vocational schools can bring about significant improvements in information technology 

teaching. It effectively stimulates students' interest in learning, fosters their collaborative 

learning and autonomous exploration abilities, and positively impacts teaching 

effectiveness. These findings provide valuable insights for the classroom teaching 

practice of the "Computer Application Foundation" course in secondary vocational 

schools. To further promote the use of scaffolding teaching, it was essential to cultivate 

the educational concepts of information technology teachers in these schools. Currently, 

most teachers in secondary vocational schools were unfamiliar with this teaching 

approach, limiting its widespread application in courses such as "Fundamentals of 

Computer Application". Therefore, in future teaching practices, it was crucial to prioritize 

the enhancement of teachers' educational concepts and skills. Teachers should be 

equipped with the knowledge of scaffolding teaching principles and processes, enabling 
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them to achieve better teaching outcomes through the implementation of scaffolding 

teaching strategies. 

 5.3.2 Suggestions for future research 

  For future research, it was recommended to focus on the following topics: 

  5.3.2.1 Exploring the application of scaffolding teaching in improving 

other skills or competencies, beyond the scope of the current study. This could involve 

investigating how scaffolding teaching can enhance critical thinking, problem-solving, 

communication, or other essential skills among students. 

   5.3.2.2 Investigating the integration of scaffolding teaching with 

different teaching methods to enhance learning achievement or develop specific skills in 

students. This could involve examining the combination of scaffolding teaching with 

active learning strategies, project-based learning, flipped classrooms, or other innovative 

teaching approaches to determine their effectiveness in improving students' learning 

outcomes.  

  5.3.2.3 By exploring these areas, further insights can be gained 

regarding the potential benefits and applications of scaffolding teaching in diverse 

educational contexts, contributing to the advancement of effective teaching practices and 

student learning. 
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Course content structure 

Topic Title Content Duration 

1 The composition of the 

computer system 

1.1 Elements of computer system 

1.2 Types of computer hardware 

1.3 Types and functional levels of 

computer hardware 

1.4 Operating principle and 

characteristics of computer 

software and hardware 

2 hours 

2 Operation of Windows 

Operating System 

2.1 File and folder operation 

under Windows operating 

system environment 

2.2 Basic settings, personalized 

settings and account 

management operation of 

Windows operating system 

2.3 Application operation in 

Windows operating system 

2 hours 

3 Excel Spreadsheets 3.1 Operation method of Excel 

worksheet, workbook and cell 

3.2 Editing and modifying 

methods of common objects 

such as text, pictures and 

tables in Excel 

3.3 Formula, function, sorting, 

filtering and other data 

operation functions in Excel 

3.4 Simple data analysis method 

in Excel 

2 hours 
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Course content structure 

Topic Title Content Duration 

4 PowerPoint Basic 

functions and features 

4.1 PowerPoint Basic functions 

and features 

4.2 PowerPoint Start and Exit 

4.3 PowerPoint Window 

4.4 PowerPoint View mode 

2 hours 

 Total  8 hours 
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Example  

Lesson Plan 1:  Scaffolding teaching 

Lesson Plan: Unit 1 Course Code: 10111001 

Subject/ Course Fundamentals of Computer Application 

Lesson Title PowerPoint Summary 

Level Grade 1 of secondary vocational school 

Lesson Duration 2hours 

 

Lesson objectives 

1. Students can master the components of a computer system 

2. Students can master the types of computer hardware 

3. Students can master the types and functional levels of computer hardware 

 4. Students can master the operating principles and characteristics of computer 

software and hardware 

 

Learning content 

1. Elements of computer system 

2. Types of computer hardware 

3. Types and functional levels of computer hardware 

4. Operating principle and characteristics of computer software and hardware 

 

Activity 

The learning 

management through 

the scaffolding teaching  

Activity of Learning Management through the 

scaffolding teaching 

Set up support. 

 

1. Teachers welcomed students to participate in learning. 

2. The teacher asked the students if they had used 

computers and for how long they had used them. 
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The learning 

management through 

the scaffolding teaching  

Activity of Learning Management through the 

scaffolding teaching 

Set up support 

 

3.  The teacher asked the students if they were familiar 

with the components of a computer, the common 

hardware systems included in a computer, the types of 

software systems, and their functional roles. 

4.  Based on the students' answers and their understanding 

of computer software and hardware systems, the 

teacher provided a brief history of computer 

development and explained the content of computer 

systems, the composition and functional orientation of 

computer software and hardware systems. This helped 

establish the initial framework for the course teaching 

based on the teaching materials. 

Enter the situation 

 

5.  The teacher used actual computer equipment as 

examples to demonstrate to the students the various 

hardware devices that comprise a computer. 

6.  The teacher briefly introduced the types and 

functional characteristics of the operating system and 

application software in the computer software system. 

7.  Teachers provided resources to students through the 

UMU online teaching platform, combining them with 

the content of teaching materials. Students watched 

teaching videos on their computers, integrating them 

with the content of teaching materials. 
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The learning 

management through 

the scaffolding teaching  

Activity of Learning Management through the 

scaffolding teaching 

Independent exploration 

 

8.  The teacher summarized the composition of the 

computer system, as well as the composition and 

functional characteristics of the computer hardware 

system and software system, based on the content of 

the textbook. 

9.  The teacher guided the students to sort out and 

analyze the content of the textbook and studied the 

operating principle of the computer system. 

10.  The teacher assigned independent exploration tasks 

to the students, and through the UMU platform, the 

students were required to document the types of 

equipment included in the computer hardware 

system and their functional positioning, the 

composition and functional level of the computer 

software system, and the basic process of command 

execution when the computer system runs. 

11.  Through the UMU platform, teachers provided tips 

and answers for the students' independent 

exploration process, checked their progress, and 

offered assistance when needed. 

collaborative learning 

 

12.  The teacher grouped students on the UMU platform 

and facilitated online discussions based on their 

individual progress in independent exploration. 

13.  After the discussion and exchange, each group 

selected one student to summarize and share their 

knowledge and experience regarding the computer 

system and its operating principle, which included   
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The learning 

management through 

the scaffolding teaching  

Activity of Learning Management through the 

scaffolding teaching 

collaborative learning 

 

 

the hardware composition, software composition, 

and operating principles. 

14.  The teacher assigned the learning tasks to each 

group, which included exploring how the computer 

software and hardware systems interact during 

instruction execution, identifying the types of 

various devices in the computer hardware system 

and their information interactions during operation, 

and examining the information interactions of the 

computer software system during instruction 

execution. 

15.  The teachers provided an online answering service 

for students during the collaborative learning 

process of each group. 

16.  After completing the learning task, each team 

submitted the results of their collaborative learning 

on the composition and operating principle of the 

computer system through the UMU platform. 

impact assessment 

 

17.  The teacher checked the learning results of each 

group and summarized the completion of the 

learning tasks for each group. 

18.  The teacher organized teams to evaluate each other 

and team members to evaluate each other, and they 

submitted their evaluations on the UMU platform. 
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The learning 

management through 

the scaffolding teaching  

Activity of Learning Management through the 

scaffolding teaching 

impact assessment 

 

19.  The teacher summarized the learning situation of 

each group and made a comprehensive evaluation of 

the students' mastery of the learning content, as well 

as their autonomous learning ability and 

collaborative ability. This evaluation was based on 

the group mutual evaluation and intra-group mutual 

evaluation. 

20.  The teacher released the homework after class 

through the UMU platform. The students completed 

the homework and submitted the results through the 

UMU platform. The teacher corrected the homework 

and provided feedback on the learning results. 

 

Materials/Resources 

1. Computer 

2.  PPT 

3. Teaching material 

4. UMU platform 

5. Network Learning Resources for Principles of Computer Composition 
 

Assessment 

Assessment method Assessment Tool Assessment Criteria 

Work Sample Autonomous and collaborative learning 

tasks were assigned to the students, 

focusing on the computer system and 

its operating principles. 

Pass 70 Percentage 

Test After-class homework in Textbook Pass 70 Percentage 

Class attendance  Class attendance Form Pass 70 Percentage 
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Learning achievement of the Fundamentals of Computer Application 

 

1. The collection of programs, data, and corresponding documents running in the 

computer system is referred to as _______. 

 A. Host 

B. Software system 

C. System software 

D. Application software 

2. The computing speed of the computer is ______. 

 A. Equivalent to human computing speed 

B. Lower than human computing speed 

C. Equivalent to human computing speed 

D. Much faster than human computing speed. 

3. The ASCII code can represent ______ characters. 

 A. 127 

B. 256 

C. 255 

D. 128 

4. Translating an assembly language source program into an object program requires 

______. 

 A. Monitoring procedures 

B. Assembler 

C. Machine language program 

D. Diagnostic procedures 

5. Eight bytes contain ______ binary bits. 

 A. 8 

B. 16 

C. 64 

D. 32 
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6. The main reason computers can work automatically according to people's will is 

that they use ______. 

 A. Binary number system 

B. High-speed electronic components 

C. Stored program control 

D. Programming language 

7. MHz is used to measure the performance of a computer. It refers to ______. 

 A. CPU clock dominant frequency 

B. Memory capacity 

C. Word length 

D. Operation speed 

8. In a microcomputer, ______ is integrated on the microprocessor chip. 

 A. Controller and memory 

B. Controller and arithmetic unit 

C. Calculator and I/O interface 

D. CPU and display 

9. The following external equipment does not belong to a microcomputer ______. 

 A. CPU and main memory 

B. Input device 

C. Output equipment 

D. External memory 

10. In the Explorer, after selecting a file, the operation to open the File Properties 

dialog box is ______. 

 A. Click "File" → "Properties" menu item 

B. Click "Edit" → "Attribute" menu item 

C. Click "View" → "Properties" menu item 

D. Click "Tools" → "Properties" menu item 
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11. In Word, the currently entered text is displayed in ______. 

 A. Mouse pointer 

B. The end of the document 

C. At the insertion point 

D. Before the first paragraph of the document 

12. In the main interface window of Excel 2010, the label of each spreadsheet is 

displayed in ________ of the worksheet. 

 A. Left 

B. Right 

C. Lower edge 

D. Top 

13. In Excel 2010, select a cell range and press Delete to perform the operation of 

______. 

 A. Clear content 

B. Clear comments 

C. Clear Format 

D. Clear all information 

14. In Excel, in addition to direct input, you can also use the () function. 

 A. SUM() 

B. AVERAGE() 

C. COUNT() 

D. TEXT() 

15. In Excel, the function to calculate the average value of all values in the parameter 

is (). 

 A. SUM() 

B. AVERAGE() 

C. COUNT() 

D. TEXT() 
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16. The graphical representation of worksheet data is called (). 

 A. Graphics 

B. Table 

C. Chart 

D. Form 

17. In PowerPoint 2019 slide editing, to proofread all text compositions, the operation 

should be performed in _________. 

 A. In the "Format" tab 

B. In the "Review" tab 

C. In the "Start" tab 

D. In the "Design" tab 

18. PowerPoint2019 provides users with_____ Automatic layout. 

 A. 25   

B. 28   

C. 31  

D. 30 

19. The operation that cannot be completed in the slide view of PowerPoint 2019 is 

_________. 

 A. Adjust the position of individual slides. 

B. Delete individual slides. 

C. Edit individual slides. 

D. Copy individual slides 

20. The presentation extension in PowerPoint 2019 is ________. 

 A. POT  

B. PPT  

C. DOC  

D. DOT 
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21. When referencing absolute cells in Excel, you need to add () before the address 

of the worksheet. 

 A. & 

B. $ 

C. @ 

D. # 

22.  The characteristic of binary number is ______. 

 A. There are two numbers: 1 and 2 

B. Every two into one 

C. It's people's mathematical habit 

D. Complicated calculation 

23. Microcomputer host is composed of______ form. 

 A. Calculator and display 

B. Calculators and peripherals 

C. Solvers and printers 

D. CPU and main memory 

24.  The type of presentation provided in PowerPoint for beginners to quickly create  

electronic presentations is _________. 

 A. Online Meeting Wizard 

B. Content Prompt Wizard 

C. Minutes 

D. Preset animation 

25. The desktop is the initial screen after the system is started. Which of the following 

must be the components of the desktop ______. 

 A. Scroll bar 

B. Taskbar 

C. Dialogs 

D. "Control Panel" icon 
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26. In Windows menu operation, if the color of a menu item is dim, it means ______. 

 A. Just double-click to select. 

B. You must hit three consecutive times to select. 

C. After clicking to be selected, a box will also be displayed to ask the operator 

to enter further information. 

D. In the current situation, this choice is meaningless, and there will be no reaction 

if it is selected. 

27. The following procedure is not an attachment. 

 A. Drawing 

B. Disk Cleanup 

C. Outlook 

D. Explorer 

28. Under Windows Chinese input mode, the key to switch between Chinese and 

English input modes is ______. 

 A. Ctrl+Alt 

B. Ctrl+Shift 

C. Shift+Space 

D. Ctrl+Space 

29. In Word, the setting of the drop cap command is ______. 

 A. Clipboard ribbon 

B. "Text" Ribbon 

C. "Paragraph" function area 

D. "Window" ribbon 

30. In Excel, each cell has a corresponding reference coordinate, called (). 

 A. Cell absolute address 

B. Cell reference position 

C. Cell relative address 

D. Cell working area 
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IOC (Index of Item Objective Congruence)  

Learning Management Plan through the scaffolding teaching 

for 1st year of secondary vocational students 

Research Instrument 
Expert results total IOC Result 

1 2 3 4 5    

Learning Management Plan using the traditional approach  

Unit 1 The composition of the computer system  

1. Learning Objectives 1 1 1 1 1 5 1 yes 

2. Learning Subject Matter 1 1 1 1 1 5 1 yes 

3. Learning Media Resources 0 1 1 1 1 4 0.8 yes 

4. Teaching and Learning Activities 1 0 1 1 1 4 0.8 yes 

5. Measurement and Evaluation 1 1 1 1 1 5 1 yes 

Unit 2 Operation of Windows Operating System 

1. Learning Objectives 1 1 1 1 1 5 1 yes 

2. Learning Subject Matter 0 1 1 1 1 4 0.8 yes 

3. Learning Media Resources 1 1 1 1 1 5 1 yes 

4. Teaching and Learning Activities 1 1 1 1 1 5 1 yes 

5. Measurement and Evaluation 1 1 1 1 1 5 1 yes 

Unit 3 Excel Spreadsheets  

1. Learning Objectives 1 1 1 1 1 5 1 yes 

2. Learning Subject Matter 0 1 1 1 1 4 0.8 yes 

3. Learning Media Resources 1 1 1 1 1 5 1 yes 

4. Teaching and Learning Activities 1 1 1 1 1 5 1 yes 

5. Measurement and Evaluation 1 1 1 1 1 5 1 yes 

Unit 4 PowerPoint Basic functions and features 

1. Learning Objectives 1 1 1 1 1 5 1 yes 

2. Learning Subject Matter 1 1 1 1 1 5 1 yes 

3. Learning Media Resources 1 1 1 1 1 5 1 yes 

4. Teaching and Learning Activities 1 0 1 1 1 4 0.8 yes 

5. Measurement and Evaluation 1 1 1 1 1 5 1 yes 
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IOC (Index of Item Objective Congruence)  

Learning Management Plan through the scaffolding teaching 

for 1st year of secondary vocational students 

Research Instrument 
Expert results 

Total IOC Result 
1 2 3 4 5 

Learning Management Plan through the scaffolding teaching 

Unit 1 The composition of the computer system  

1. Learning Objectives 1 1 1 1 1 5 1 yes 

2. Learning Subject Matter 1 1 1 1 1 5 1 yes 

3. Learning Media Resources 1 1 1 1 1 5 1 yes 

4. Teaching and Learning Activities 1 1 1 1 1 5 1 yes 

5. Measurement and Evaluation 1 1 1 1 1 5 1 yes 

Unit 2 Operation of Windows Operating System 

1. Learning Objectives 1 1 1 1 1 5 1 yes 

2. Learning Subject Matter 1 1 1 1 1 5 1 yes 

3. Learning Media Resources 1 1 1 1 1 5 1 yes 

4. Teaching and Learning Activities 1 1 1 1 1 5 1 yes 

5. Measurement and Evaluation 1 1 1 1 1 5 1 yes 

Unit 3 Excel Spreadsheets 

1. Learning Objectives 1 1 1 1 1 5 1 yes 

2. Learning Subject Matter 1 1 1 1 1 5 1 yes 

3. Learning Media Resources 1 1 1 1 1 5 1 yes 

4. Teaching and Learning Activities 1 1 1 1 1 5 1 yes 

5. Measurement and Evaluation 1 1 1 1 1 5 1 yes 

Unit 4 PowerPoint Basic functions and features 

1. Learning Objectives 1 1 1 1 1 5 1 yes 

2. Learning Subject Matter 1 1 1 1 1 5 1 yes 

3. Learning Media Resources 1 1 1 1 1 5 1 yes 

4. Teaching and Learning Activities 1 1 1 1 1 5 1 yes 

5. Measurement and Evaluation 1 1 1 1 1 5 1 yes 
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IOC (Index of Item Objective Congruence)  

Learning achievement test  

on The Fundamentals of Computer Application 

Item test 
Expert results 

Total IOC Result 
1 2 3 4 5 

1 1 1 1 1 1 5 1 yes 

2 1 1 1 1 1 5 1 yes 

3 0 1 1 1 1 4 0.8 yes 

4 1 1 1 1 1 5 1 yes 

5 1 1 1 1 1 5 1 yes 

6 1 1 1 1 1 5 1 yes 

7 1 1 1 1 1 5 1 yes 

8 1 1 1 1 1 5 1 yes 

9 1 1 1 1 1 5 1 yes 

10 1 1 1 1 1 5 1 yes 

11 0 1 1 1 1 4 0.8 yes 

12 1 1 1 1 1 5 1 yes 

13 1 1 1 1 1 5 1 yes 

14 1 0 1 1 1 4 0.8 yes 

15 1 1 1 1 1 5 1 yes 

16 1 1 1 1 1 5 1 yes 

17 1 1 1 1 1 5 1 yes 

18 1 1 1 1 1 5 1 yes 

19 1 0 1 1 1 4 0.8 yes 

20 1 1 1 1 1 5 1 yes 

21 1 1 1 1 1 5 1 yes 

22 1 1 1 1 1 5 1 yes 

23 1 1 1 1 1 5 1 yes 

24 1 1 1 1 1 5 1 yes 

25 1 1 1 1 1 5 1 yes 
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IOC (Index of Item Objective Congruence)  

Learning achievement test  

on The Fundamentals of Computer Application 

Item test 
Expert results 

Total IOC Result 
1 2 3 4 5 

26 1 1 1 1 1 5 1 yes 

27 1 1 1 1 1 5 1 yes 

28 1 1 1 1 1 5 1 yes 

29 1 1 1 1 1 5 1 yes 

30 1 1 1 1 1 5 1 yes 
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